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Features Specifications

® High-density plug-in Xilinx Spartan-6
module

® USB 2.0 interface with high-speed
(480 Mbit/s) data rate

® Large SPI Flash for configuration and user
data, accessible via FPGA, JTAG and USB
interfaces

® Large DDR3 SDRAM

FPGA configuration via SPI, JTAG or USB

® 3 high-efficiency on-board switch-mode
DC-DC converters

® Power supply from B2B connector (carrier
board) or USB connector

® Flexible expansion via high-density
shockproof B2B connectors

® Most user I/Os on B2B connectors routed
as LVDS pairs

® Evenly spread supply pins for good signal
integrity

® Industrial temperature grade available
upon request

® Low-cost, versatile and ruggedized
design

® Small size

® FPGA - XC6SLX45/75/100/150-
2CSG484C(l)

® USB-controller: CY7C68013A-56LTXC(l)

® Non-volatile memory: 64 Mbit SPI Flash
for configuration and user data

® Volatile memory: 1 Gb x 16 DDR3
SDRAM

® Up to 110 FPGA user I/O

® Supply voltage range: 4.0V -5.5V

® 1 user push-button

® 4 user LEDs

® 2 user DIP switches

® Dimensions: 40.5 mm x 47.5 mm
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1 Technical Specifications UM-TEO0630 (v 0.21) 3 July 2013

1 Technical Specifications

1.1 Module options
FPGA options

Module can be ordered with Spartan-6 XC6SLX45, XC6SLX75, XC6SLX100,
XC6SLX150 chip’.

Temperature grade options

Module can be ordered in commercial or in extended (from -25 C° to +85 C°)
temperature grade.

1.2 Dimensions

Figure 1 shows main module dimensions from top view.
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Figure 1: Module dimensions in mm

Mounting hole diameter is 3.2 mm.

1 Contact Trenz Electronic support for availability
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2 Detailed Description UM-TEO0630 (v 0.21) 3 July 2013

2 Detailed

Description

2.1 Block Diagram

Jo

EEFE.OM 24 MHz 1Gb (128MB)
241.C128 clock DDR3 SDRAM

B2B  [Jsg - B2B
J1 | d 22x0+12=56 94

USE [2C User /O
JTAG
USB MmCcu -
Cypress EZ-UUSBE e
CY7CB3013A
Xilinx FPGA -
SPI Spartan-6 LX
KCOSLX45/75/100/130
100 MHz
SPI Flash clock
64 Mbit
(system + user)

182 +18=54 User /O

2xDIP

4xLED FB switch

Figure 2: TE0630 block diagram

2.2 Power Supply

The module can be powered by B2B connector J5 or the USB connector. If both
power supplies are available, the B2B connector power supply takes
precedence, disabling the USB power supply automatically.

2.2.1 Supply from B2B Connector

The B2B connector power supply requires a single nominal 5 V DC power
supply. The power is usually supplied to the module through the 5 V contacts
(5Vb2b) of B2B connector J5 (see chapter 6.4 J5 Pin-out). The recommended
minimum supply voltage is 4 V. The maximum supply voltage is 5.5 V. The
recommended maximum continuous supply current is 1.5 A.

2.2.2 Supply from USB Connector

The module is powered by the USB connector if the following conditions are
met:

® the module is equipped with an USB connector,

® the module is connected to a USB bus,
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2 Detailed Description UM-TEO0630 (v 0.21) 3 July 2013

® no power supply is provided by B2B connectors.

In this case, other components (e.g. extension or carrier boards) may also be
powered by the corresponding 5 volt line (5V) of B2B connector J5.

2.2.3 On-board Power Rails

Three on-board voltage regulators provide the following power supply rails
needed by the components on the module:

® 1.2V, 3.0 Amax
® 2.5V, 0.8 Amax
e 3.3V, 3.0 Amax
® 1.5V, 1.0 Amax

Figure 3 show power supply diagram.
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Figure 3: TE0630 Power diagram

The power rails are available for the FPGA and can be shared with a carrier
board by the corresponding lines of the B2B connectors J4 and J5. Please
note that the power consumption of the FPGA is highly dependent on the
design actually loaded. So please use a tool like Xilinx Xpower to estimate the
expected power consumption of your design.

Even if the provided voltages of the module are not used on the carrier board, it
is recommended to bypass them to ground with 10 nF - 100 nF capacitors.

FPGA 1/O banks power supply

Spartan-6 architecture organizes I/Os into four I/O banks, see Table 1 for supply
voltage used for each bank.

VCCIOO voltage can be configured in 3 ways:

® 2.5V - When resistor R103 is populated and resistor R102 is not
populated.

® 3.3V - When R103 is not populated and resistor R102 is populated.
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2 Detailed Description UM-TEO0630 (v 0.21) 3 July 2013

® External supply - When R103 is not populated and R102 is not
populated. In this case external supply source have to be connected to pins
1, 2, 3, 4 of J4 B2B connector?.

Others options of VCCIO0 power supply are not supported and can
damage the FPGA!

See Figure 4 to locate R102 and R103 on PCB.

Figure 4: R102 and R103 location

Supply

Voltage
BO VCCIOO0
B1 1.5V
B2 3.3V
B3 3.3V

Table 1: FPGA banks VCCIO power supply

Note that some of Spartan-6 I/O types are partially compatible, so pins of
compatible types can be used as inputs for signal of other type. See “Spartan-6
FPGA SelectlO Resources” page 38 for detailed information.

2.2.4 Power-on Reset

During power-on, the /RESET line is first asserted. Thereafter, the supply
voltage supervisor monitors the power supply rail 3.3V and keeps the /RESET
line active (low) as long as the supply rail remains below the threshold
voltage(2.93 volt). An internal timer delays the return of the /RESET line to the
inactive state (high) to ensure proper system reset prior to a regular system
start-up. The typical delay time ty of 200 ms starts after the supply rail has risen

2 See Spartan-6 documentation fo VCCIO power range.
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2 Detailed Description UM-TEO0630 (v 0.21) 3 July 2013

above the threshold voltage.

3.3V

IRESET]

Figure 5: Reset on power-on

After this delay, the /RESET line is reset (high) and the FPGA configuration can
start. When the supply rail voltage drops below the threshold voltage, the
/IRESET line becomes active (low) again and stays active (low) as long as the
rail voltage remains below the threshold voltage (2.93 volt). Once the rail
voltage raises again and remains over the threshold voltage for more than the
typical delay time t4 of 200 ms, the /RESET line returns to the inactive state
(high) to allow a new system start-up.

2.3 FPGA User I/Os

TE0630 provides user I/O signals connected to B2B connectors J4 and J5.
There are 3 types of user I/O signals:

® Single ended;
@ Differential pairs (each pair is configurable as 2 single-ended digital 1/0Os);

@ Differential pairs, which can be used as clock inputs (each pair can be used
as usual differential pair or 2 single-ended digital 1/0s).

Table 2 show user I/O count for J4 and J5.

J4 J5 Total
Single ended 12 18 30
Differential 18 16 34
Differential (clock) 4 2 6
Total 56 54 110

Table 2: User I/0 count by connector

Table 3 show user I/O divided by VCCIO supply voltage.

VCcCIoo 3.3V Total
Single ended 1 29 30
Differential 18 16 34
Differential (clock) 4 2 6
Total 45 65 110

Table 3: User I1/0 count by VCCIO

8/39

www.trenz-electronic.de TE0630 Spartan-6 FPGA Industrial Micromodule



2 Detailed Description UM-TEO0630 (v 0.21) 3 July 2013

2.4 Board-to-board Connectors

The module has two B2B (board-to-board) receptacle connectors (J4 and J5)
for a total of 160 contacts. Figure 6 shows B2B connectors location on board;

USB connector is located on the top side and is shown to define module
position.

Figure 6: B2B connectors location

TEO0630 uses high-density shockproof connectors shown in Figure 7. Connector
part numbers are listed in Table 4.

Figure 7: Module connector

Supplier Header
H11113CT-ND
Digikey H11113TR-ND
H11113DKR-ND
Hirose DF17(3.0)-80DS-0.5V(57)
Trenz Electronic 22684

Table 4: Module connectors part numbers

The on-board receptacles mate with their corresponding headers on the carrier

board shown in Figure 8. Ordering numbers of mating connectors are listed in
Table 5.
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2 Detailed Description UM-TEO0630 (v 0.21) 3 July 2013

Figure 8: Mating (carrier board) connector

Supplier Header
H11148DKR-ND
Digikey H11148TR-ND
H11148CT-ND
Hirose DF17(4.0)-80DP-0.5V(57)
Trenz Electronic 22938

Table 5: Carrier board headers part numbers.

Figure 9 shows the definition of stacking height featured by the combination of
the TEOG30 receptacle with its corresponding header.

] —+—1 Receptacle
" /
o Header
+
e /
1 | . 1 : L
N

Figure 9: B2B stacking

The stacking height of the TE0630 B2B connectors is 7 (seven) mm. The
stacking height does not include the solder paste thickness.

2.5 USB Connector

The module uses a mini-USB (B type) receptacle connector.
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2 Detailed Description UM-TEO0630 (v 0.21) 3 July 2013

Figure 10: Mini-USB connector

2.6 JTAG connector

The offset holes of header J2 allow a removable press fit of standard 0.100 inch
header pins to connect flying leads without any soldering necessary. JTAG
signals are available on the dedicated header J2 through a JTAG programmer
with flying leads as described in Table 6.

TMS

TDI

TDO

Vref (2.5 V)

Table 6: JTAG header J2 pin-out

2.7 Serial EEPROM

TE0630 is equipped with a Micron Technology 24LC128 128 K 1°C CMOS Serial
EEPROM (U1). It is used for EZ-USB FX2 firmware, vendor ID and device ID
storage. EEPROM is accessible through the EZ-USB FX2 microcontroller.

2.8 SPI Flash

TEO0630 is equipped with a Winbond W25Q64BV 64 Mb (8 MB) serial flash
memory chip (U14). This serial flash chip can operate as general SPI memory
mode and in double or quad modes. Usage of dual and quad modes increase
bandwidth up to 40 MB/s. For more information see Winbond W25Q64BV
product owerview.
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2 Detailed Description UM-TEO0630 (v 0.21) 3 July 2013

2.9 DDR3 SDRAM

TE0630 is equipped with a 1 Gb (128 MB) DDR3 SDRAM chip. DDR3 memory
is connected to FPGA bank 1.

2.10 USB Controller

TEO0630 is equipped with a Cypress EZ-USB FX2 controller to provide a high-
speed USB 2.0 interface. The controller uses 4 interfaces (See chapter 2.1
Block Diagram):

® USB interface (to USB connector);
® |°C interface (to EEPROM);

® SPl interface (to FPGA and Flash);
® FIFO interface (to FPGA).

The I?C interface connects the USB controller to the EEPROM chip, which
stores vendor ID and device ID. See chapter 2.14 DIP Switch for available
options.

The SPI interface id used to communicate with the FPGA and to access the SPI
serial Flash chip.

The FIFO interface provides a high-speed communication channel with the
FPGA. The interface can transfer up to 48 MB/s burst rate. FPGA pin-out
information can be found in Table 7.
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2 Detailed Description UM-TEO0630 (v 0.21) 3 July 2013

Signal name FPGA pin

FDO J6

FD1 H8

FD2 H5

FD3 H6

FD4 G7

FD5 G8

FD6 F8

FD7 A3
24MHZ1 G3
PAO/INTO D1
PA1/INT1 D2
PA2/SLOE C1
PA3/WU E4
PA4/FIFOADDRO B1
PAS/FIFOADDRH1 C3
PAG/PKTEND B2
PA7/FLAGD/SLCS A2
RDY1/SLWR M3
RDYO/SLRD M4
CTL2/FLAGC E3
CTL1/FLAGB E1
CTLO/FLAGA F3
IFCLK N4

Table 7: USB controller interface: FPGA pin-out

2.11 Clock Oscillators

Two clock oscillators are installed on the TE0630.

Clock oscillator U10 generates a 24 MHz clock signal for the FPGA and the
USB controller. This clock signal is used for synchronous communication
between FPGA and USB controller.

Clock oscillator U11 generates a 100 MHz? clock signal used as a main system
clock in FPGA designs. See Table 8 for pin-out information.

Signal Frequency FPGA pin
24MHZ1 24 MHz G3
SYSCLK 100 MHz AA12

Table 8: Clock signals pin-out

2.12 LEDs
TE0630 is equipped with four active-high LEDs. See Table 9 for details.

3 Oscillator frequency can be changed by user request. Contact Trenz Electronic for details.
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2 Detailed Description UM-TEO0630 (v 0.21) 3 July 2013

Signal name FPGA pin LED
U_LED1 F1 D3
U_LED2 F2 D5
U_LED3 J4 D6
U_LED4 K8 D7

Table 9: LEDs pin-out

2.13 Push-Button

TE0630 module is equipped with one active-high push-button (signal is set to
logical "1" when button is pressed). Table 10 show push-button connection

details.
Signal name FPGA pin PB
PB R7 S5

Table 10: Push button pin-out

2.14 DIP Switch

On-board 4xDIP switch S1 used for system and user settings.

Switch 1 (S1A) is used to connect the USB controller to the 1°C serial EEPROM.
When S1Ais "ON", serial I>°C EEPROM is connected to the USB controller,
when switch is "OFF", the USB controller is disconnected from the EEPROM*.
Turn S1A off when programming the USB EEPROM (storing the USB vendor ID
and device ID). This will force the USB controller to provide its default vendor ID
and device ID.

Switch 2 (S1B) is used to control DC-DC converters. When switch is "OFF",
converters are controlled by the USB controller. When switch is "ON",
converters are enabled regardless of USB controller actions. At start-up, the
USB controller switches off 1.2V, 1.5V and 2.5V power rails and starts up the
module in low-power mode. After enumeration, the USB controller firmware
switches the 1.2V, 1.5V and 2.5V power rails on, if enough current is available
from the USB bus.

Switches 3 (S1C) and 4 (S1D) can be used as user switches. Switches are
active-low. Pull-up resistors should be defined in user constrains file (UCF) to
use this switches in FPGA design. See Table 11 for details.

Signal name FPGA pin Switch
I0_L61_N_1 AB21 S1C
10_L63_N_1 AA22 S1D

Table 11: DIP switch pin-out

2.15 Board revisions and assembly variants

To determine PCB revision and assembly variant from FPGA, TE0O630 have
dedicated user signals, which can be read by user core.

Board revision coded in 4 bits BR[3:0]

4 Zero-resistor R90 (not populated by default) short this switch and connect EEPROM regardless of S1A position.
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Signal name FPGA pin

BRO R19
BR1 V19
BR2 V20
BR3 T17

Table 12: Board revision pins

To define low (zero) level BR pin connected to ground rail, to define high (one)
level BR pin left float (open). These pins should be configured with "pullup”
option in user design.

See Table 12 for current list of board revisions.

BR3 BR2 BR1 BRO
0 0 0 0 00 Initial revision

Table 13: Board revisions

Module assembly variant encoded using AV[3:0] pins.

Signal name FPGA pin

AVO Y20
AV1 R15
AV2 R16
AV3 R17

Table 14: Assembly variants pins

To define low (zero) level AV pin connected to ground rail through zero resistor,
to define high (one) level AV pin left float (open). These pins should be
configured with "pullup" option in user design.

Available module assembly variants listed in Table 15.

AV3 AvV2 AV1 AV0

0 0 0 0 Base assembly variant

Table 15: Module assembly variants

3 TE0300 compatibility

TE0630 module designed to be compatible with TE0300 board by main
mechanical and electrical characteristics.

3.1 Mechanical compatibility

Both modules have the same board dimensions. TE0630 mount holes and B2B
connectors locations are match with TE0300. See chapter 1.2 Dimensions for
detailed information.

TEO300 and TE0630 uses same B2B connectors types. In chapter 2.4 Board-
to-board Connectors you can find B2B connectors part numbers and main
characteristics.

3.2 Electrical compatibility

TEO0300 and TE0630 have similar power requirements and matched power
input pins. User signals to B2B connectors routed as differential pairs and single

15/39 www.trenz-electronic.de TE0630 Spartan-6 FPGA Industrial Micromodule



3 TEO300 compatibility

UM-TE0630 (v 0.21) 3 July 2013

ended lines. Differences in pin types shown in Table 16, not listed signals have
same or compatible® type.

Connector:Pin TE0300 pin name TEO0300 Type TEO0630 pin name TE0630 Type

J4:5 B3_LO1_P DIO V3_l0_01 slo
Ja:7 B3_L01_N DIO V3_l0_02 slo
J4:9 B3_L02_P DIO V3_l0_03 slo
Ja:11 B3_L02_N DIO V3_l0_04 sIo
J4:17 BO_L24 N DIO V0_IO_01 slo
Ja:19 BO_L24 P DIO V0_I0_01 N DIO
J4:6 B3 _LO7_P DIO V3_l0_06 slo
J4:8 B3_LO7_N DIO V3_l0_07 slo
J4:10 B3_L03_N DIO V3_I0_08 slo
Ja:12 B3_L03_P DIO V3_l0_09 slo
J5:13 B3 L22 P DIO V3_10_12 sio
J5:15 B3 L22 N DIO V3_10_13 slo
J5:19 B3 _L20 P DIO V3_10_14 sIo
J5:21 B3_L20 N DIO V3_10_15 slo
J5:16 B3_L21 N DIO V3_10_17 slo
J5:18 B3 L21 P DIO V3 10_18 slo
J5:20 B3_L23 N DIO V3_10_19 slo
J5:22 B3 L23 P DIO V3_I0_20 sIo
J5:32 B2_L06_P DIO V3_l0_24 slo
J5:34 B2_L06_N DIO V3_l0_25 slo
J5:41 B2_GCLK13 clo V2_10_02 slo
J5:49 B2_GCLK_L13_N clo V2 10 24 P DIO
J5:51 B2_GCLK_L13_P clo V2 10 24 N DIO

Table 16: TE0300 and TE0630 pin types differences.

See Table 17 for pin types definitions.

Type
colour code

DIO

Description

Unrestricted, general-purpose differential user-1/0O pin.

SIO

Unrestricted, general-purpose user-1/O pin.

CIO

Unrestricted, general-purpose differential user-1/O pin. This pin also can be used as FPGA clock input.

Table 17: TE0300 and TE0630 pin types

Most user signals to B2B connectors routed from same FPGA banks.
Differences shown in Table 18.

5 Signals routed as differential pairs can be used as single ended.
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3 TEO300 compatibility UM-TE0630 (v 0.21) 3 July 2013

Connector:Pin TEO0300 Bank TE0630 Bank
J4:15
J4:36
J4:52
J5:33
J5:28
J5:30
J5:32
J5:34
J5:38
J5:40
J5:42
J5:50
J5:52

Table 18: TE0300 and TE0630 user signals /O banks differences.
I/O Banks power supply for both modules shown in Table 19.

o
w

N ININ W W W Ww w w w w

W W W W dMNININMNINMNINMINIO|O

N

Bank TE0300 TE0630
BO VCCIO (1.2V-33V) | VCCIO (12V-33V)
B1 25V 15V
B2 3.3V 3.3V
B3 3.3V 3.3V

Table 19: TE0300 and TE0630 FPGA I/O banks power supply.

Bank 0 1/0 supply voltage at both modules can be configured by user, see
chapter 2.2.3 On-board Power Rails.

4 Module Configuration
Full module configuration cycle (for just assembled board) include steps:
Generic USB driver installation
USB microcontroller large EEPROM programming
EEPROM programming

Bwn =

Dedicated driver installation
5. SPI Flash configuration

Steps 1-3 already performed at Trenz Electronic laboratory, and not required
to perform by end user.

To work with TE0630 module using USB interface user should install dedicated
USB driver, which provide API to work with main module functions, for complete
instructions see chapter 5.2 Dedicated driver installation.

The FPGA on the TE0630 can be configured by SPI Flash or by JTAG
connector.

4.1 JTAG FPGA Configuration

Programming using JTAG interface provide convenient and fast way to test
FPGA project. FPGA configuration programmed this way is volatile and lost
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after reset or power cycle.

4.2 SPI FPGA Configuration

The bit-stream for the FPGA is stored in the SPI Flash. To use this bit-stream
source FPGA configuration option is set to “Master Serial/SPI”. See 2.8 SPI
Flash for additional information.

SPI Flash can be programmed in several ways:

® Direct programming by USB controller (usually done by Firmware Upgrade
Tool).

® Indirect SPI programming via FPGA pins, controlled by JTAG (can be done
using Xilinx IMPACT). See Appendix A. Indirect SPI Programming using
iMPACT.

® Direct SPI programming by FPGA, using an SPI core (FPGA project should
contain SPI interface core and software to work with it).

In SPI Flash mode, the FPGA's internal oscillator generates the configuration
clock frequency. The FPGA provides this clock on its CCLK output pin, driving
the PROM'’s Slave Clock input pin. The FPGA begins configuring using its
lowest frequency setting. If so specified in the configuration bitstream, the FPGA
increases the CCLK frequency to the specified setting for the remainder of the
configuration process. The maximum frequency is specified using the
ConfigRate bitstream generator option. The maximum frequency supported by
the FPGA configuration logic depends on the timing for the SPI Flash device.
For TE0630 SPI Flash PROM, use ConfigRate = 12 or lower.

This options are set graphically in Xilinx ISE Software Project Navigator by
selecting the following:

® Generate Programming File > Process Properties > Configuration Options >
Configuration Rate > 12 (or lower)

4.3 eFUSE programming

To program eFUSE at TE0630 module follow the steps below.

® Connect 2.5V power rail to 3.3V power rail. It can be done on B2B connector
see 6 B2B Connectors Pin Descriptions. Or if module connected to
baseboard, better to short power rails on baseboard.

® Program eFUSE using JTAG cable and iMPACT software.

® Disconnect 2.5V and 3.3V power rails.

4.4 EZ-USB FX2 Firmware Programming

TE0630 module supplied with already programmed FX2 firmware, so this
procedure is not needed for normal work flow. This procedure is required
only if custom firmware used or to restore firmware.

If the EEPROM has never been programmed before (virgin module) Switch 1
(S1A) can be switched to EEPROM (to "ON" state). See chapter 2.14 DIP
Switch for details. The USB microcontroller will detect an empty EEPROM and
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will provide its default vendor ID and device ID to the USB host. If the EEPROM
has been programmed before (EEPROM not empty), S1A must be switched to
"OFF". The USB microcontroller will detect a missing EEPROM and will provide
its default vendor ID and device ID to the USB host.

4.5 EZ-USB FX2 EEPROM Programming

TE0630 module supplied with already programmed EEPROM, so this
procedure is not needed for normal work flow. This procedure is required
only if custom firmware used or to restore firmware.

First of all, check that Switch 1 (S1A) is actually switched to EEPROM. The
USB EEPROM can be programmed by opening the dedicated software
“Cypress USB Console” (double click the “CyConsole.exe” file in the
“1st_program\CyConsole” folder).

T Cypress USB Console

File ©Options Help
% [=] @ [x] Selected Script: X % (5 24/?

Select Device

USE Addrezz | Device Mame Mame in windows Device Mar [from .inf]

ienerc USE Device

Device Fropertties | Control Endpt Xfers] DtherEndthfers] Mizc. ]

VendorlD ... .. 0x04B4 Class .. ... O=FF
PraductD .. ... 0x8613 Subclass . . 04FF
M anufacturer . . . Protocal . . OxFF
Product. ... ... becdDevice OxA001

Serial Number . .

Device Configurations [ 1]
Yalue | Attributes | I i Piowwer |
0x01 080 0232 (100 ma)

Configuration Interfaces [4)

|t | Al Setting | Clazs | Subclazs Pratocol ~
u] u] 0xFF [ Wendor ] OxFF OxFF
] 1 0=FF [ Wendaor ) 0=FF 0=FF
] 2 0=FF [ Wendar ) 0=FF 0=FF hd

Interface Endpointz [ 0]
Address | Aftributes Max Pkt Size Irteryval

Click “Options > EZ-USB Interface” to Open EZ-USB Interface window.
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T EZ-USB Interface

Device |USB Device | [y o | Lozdnin | s EcpRom | seeotin |

et Dew | Get Cont | Get Pipes | Bet Strir\gs| Dourload ‘ |§.gEEPRDM URB Stat ‘ HOLD | RUN |
w Reo [0x00 Yalue [0x0000 Incex [0x0000 Length [0 ©Di [0 OUT | HexBytes [CO B4 04 81 00 01 00 +|
ot | Pipe | Lengh [128°  PacketSize [ Packets [
Q Pipe | v Lergin [64 Hex Bytes [5 |

Reset Pipe | Aot Pipe ‘ File Trans .. | Fipe -
Set [Face | Interface ’0_ AltSetting ’l]_

“S EEPROM?” button refers to the small EEPROM (256 bytes) whereas the “Lg
EEPROM’ refers to the large EEPROM (64 KB). Press the “Lg_EEPROM”
button, select the “USB.iic” file and press the “Open” button to start writing to
EEPROM.

Large (512 - 64K byte) EEPROM Download
Suchenin: | (= TEO300 =] e ®mcFE-

= | E[‘_"]driver
! I CvCansale

Zuletzt

wverwendete D

i
11

g
5

Deskiop

®

Eigene Diateien

L&l

Arbeitzplatz

Dateiname: |usb.iic: :] Qffren |
:_J Abbrechen

Metzwerkumgeb  Dateityp: |i2c: EEFROMM Files [*.iic]

=L I Schieibgeschiitzt Sfnen

Upgrade progress is displayed in status window and is completed when
“Download Successful” text is displayed.
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7 EZ-USB Interface Q'E'@

Device |USB Device =] [ ctear | omdwin | 5 EceRoM | seletten |

Get Dev ‘ Get Conf ‘ Get Fipes | Get Stnngs| Download | |i@"é’E’#'ﬁﬁi&k URB Stat | HOLD | RUN ‘
vénd Req | Req [0400 Valuz [0084E. Index [040000 Length [0 DF[0OUT ~| HexBytes [CO B4 04 8100 0100 +|
_oTans | Pige v| Lengh [1287 PacketSize | Packels [
4 Fige | | Lenath [64 Hex Bytes [5 =]

Reset Pipe‘ Abort Pipe | File Trans. | Pipe -
Set IFace Interface'u_ AltSetting ’l]_

oQoo 0Z 0D SL A
Dovmload 1Z bytes: addr=d3l

o000 78 7F E4 FE D& FD 75 &1 3E 0Z 0F Eé

Dovmload 96 bytes: addr=84e

0000 EB 01 OC EE 92 Z9 FE BE Eb 83 34 FE 23 EO0 ZE B0
0010 0& E9 Z5 82 F2 E6 ZZ BB FE 06 E9 25 32 F8 EE ZZ
00z0 EE 82 29 FE 9Z EE 83 3A F& 83 E4 93 ZZ F2 BB 01
0030 0D ES5 Bz Z5 FE& 282 ES 82 3A FE 23 E2 FO EZ &S0 06
0040 ES Z5 B2 C8 F& ZZ BB FE 0L E9 25 8Z €8 FZ ZEZ EBE
0050 SF FE& FO EA SE 42 FO ES 5D 42 FO E2 3C 45 FO ZZ
Toggle 5051 Reset {(00)

Dowvnloading file: C:3ZTE030DMush.iic

Dovmloading 4096 bytes to addr=0

Dowvmloading 1331 bytes to addr=1000

Dovmload Successful: E4Z7 bytes dowmloaded

v

After that EEPROM will contain right VID/PID. To apply changes reconnect USB
cable.

5 USB Drivers Installation

To provide convenient interface from host computer to TE0630 module, USB
driver should be installed to operating system. There is 2 drivers to work with
TE0630 module:

® Generic driver, which work with default controller configuration.
® Dedicated driver, which works with custom FX2 firmware.

Generic driver used only for initial USB microcontroller programming and not
needed for normal work flow.

Most TEO630 users need to install only dedicated driver see chapter 5.2
Dedicated Diriver.

5.1 Generic Driver

Most users don't need this driver, this driver used only for initial USB
microcontroller programming, which was already done for all supplied TEO630
modules.

If the USB microcontroller (Cypress EZ-ESB FX2) driver is not installed on the
host computer, then the easiest way to do it is the following:

® disconnect the module if it connected or leave the module unconnected;

® configure the module such that the USB microcontroller will provide its
default vendor ID and device ID to the USB host (i.e. Switch 1 (S1A) = "OFF"
-- see chapter 4.4 EZ-USB FX2 Firmware Programming);

® connect the module to the host computer through the USB interface;

® wait until the operating system detects new hardware and starts the
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hardware assistant;

® put Switch 1 (S1A) to "ON" (EEPROM connected to USB microcontroller);

® answer the hardware assistant questions as shown in the following example.

Assistent fiir das Suchen neuer, Hardware

Willkommen

USE Device

jetzt ein.

bt diesem desistenten konnen Sie S oftware fiir die folgende
Hardwarekomponents instalieran:

’ '_) Falls die Hardwarekomponente mit einer CD
\_4_ oder Digkette geliefert wurde, legen Sie diese

Wwie mochten Sie vargehen?

(3 Software automatizch instalieren [empfohlen)

(®)Eaftware von ener Liste oder bestimmten Huele
iinztallieran [fur fortoeschrittene Benutzer) :

Klicken Sie auf "weiter'', um den Yargang fortzuzetzen.

[ Weiter ] [Abbrechen l

Assistent fiir, das Suchen neuer, Hardware

Wahlen Sie die Such- und Installationsoptionen.

Folgends Quelle ebenfalls durchsuchen:
C:ATEQZ00Ndriver

(%) Diese Quellen nach dem zutreffendsten Treiber durchsuchen

Wemnwenden Sie die Kontrollk 3stchen, um die Standardsuche zu enweitern oder
einzuschranken. Lokale Plade und Wechzelmedien sind in der Standardsuche mit
einbegriffen. Der zutreffendste Treiber wird installiert.

[[]'wechselmedien durchsuchen [Diskette, CD.,...]

() Nicht suchen, sondem den zu installierenden Treiber selbst wihlen

Wenwenden Sie diese Option, um einen Geratetreiber aus einer Liste zu wahlen, Ex wird
nicht garantiert, dazs der won lhnen gewahlte Treiber der Hardware am besten entzpricht.

¢ Zurick ” Wieiter » ] [Abbrechen
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Hardwareinstallation

] ‘_\ Die Software, die fur diese Hardware installiert wird:
L]

Cypress Genenc USE Device

hat den *Windows-Logo-Test nicht bestanden, der die F.ompatibilitat mit
Windows XP Uberpriift. [warum izt disser Test wichti?]

Das Fortzetzen der Installation dieser Software kann die korrekte
Funktion des Systems direkt oder in Zukunft beeintrachtigen.
Microzoft empfiehlt strengstens, die Installation jetzt abzubrechen
und sich mit dem Hardwarehersteller fur Software, die den
Windows-Logo-Test bestanden hat, in Yerbindung zu setzen.

| Installation fortsetzen | ’ Installation abbrechen

Assistent fiir das Suchen neuer, Hardware

Fertigstellen des Assistenten

Die Software fur die folgende Hardware wurde ingtalliet;

=

Cyprezz Generic USE Device

Klicken Sie auf "Fertig stellen”, um den Yargang abeuschlisfen.
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g Gerdte-Manager

Datei  Akbion  Ansicht 2

B EE 2 A <=<n8

+ @ Prozessoren
+-%g Speichervolumes
+ _} Systemgerste
+)-4 Tastaturen
= E&D USB-Corkroller

& Ca-200
2 s Genetic LISE Device
R ICHS Family USE Universal Host Controller - 2830
R} ICHS Family USE Universal Host Contraller - 2831
R ICHS Family USE Universal Host Controller - 2832
R ICHE Family USE Universal Host Controller - 2834
82 IntelfR) ICHS Family 1SB Universal Host Controller - 2835
82 IntelfR) ICHS Family 11SB2 Enhanced Host Contraler - 2536
2 IntelfR) ICHE Family 10582 Enhanced Host Controller - 2834
8% USB-Rook-Hub
& USB-Raot-Hub
8% USB-Rook-Hub
& USB-Root-Hub
8% USB-Rook-Hub
82 USB-Root-Hub
8% USB-Rook-Hub

& Intel
& Intel
&2 Intel
& Intel

After that I>°C EEPROM should be programmed with right Vendor ID / Device
ID, see chapter 4.5 EZ-USB FX2 EEPROM Programming.

5.2 Dedicated Driver

This driver used to work with modules which have DEWESoft firmware and
Vendor ID / Device ID programmed. All TEO630 modules supplied with
programmed USB controller and corresponding Vendor ID / Device ID in

EEPROM.

Before connect USB cable, check that Switch 1 (S1A) is on "ON" state (USB
controller connected to EEPROM).

Connect USB cable and wait until the operating system detects new hardware
and starts the hardware assistant and answer the hardware assistant questions
as shown in the following example.

www.trenz-electronic.de
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Assistent fiir das Suchen neuer Hardware

Willkommen

Mit diezem Azziztenten konnen Sie Software fur die folgende
Hardwarekomponente installieren:

DeweSoft USE Device

; '_) Fallz die Hardwarekomponente mit einer CD
4 oder Diskette geliefert wurde, legen Sie diese
jetzt ein.

‘Wie mochten Sie vorgehen?

(O Software automatizch instaliersn (empfohlen)

() Sottware von einer Liste oder bestimmten Guelle
iinstallieren [fur fortgeschiittene Benutzer] i

Klicken Sie auf "wWeiter”, um denYorgang fortzuzetzen.

I W eiter > l [Abbrechen ]

Assistent fiir das Suchen neuer Hardware

W ahlen Sie die Such- und Installationsoptionen.

Yerwenden Sie die Kontrollkastchen, um die Standardsuche zu enweitern oder
einzuzchranken. Lokale Pfade und Wechselmedien sind in der Standardsuche mit
einbegriffen. Der zutreffendste Treiber wird installiert.

[ 'wechselimedien durchsuchen [Diskette, CD,...)
Folgende Quelle ebenfalls durchsuchen:

CATE30Ddiiver v

() Hicht suchen, sondern den zu instalierenden Treiber selbst wahlen

Verwenden Sie diese Optioh, um einen Geratetraiber aus einer Liste 2u wahlen, Eg wid
nicht garantiert, dass der von lhnen gewshlte Treiber der Hardware am besten entspricht.

’ £ Zuriick ” Wieiter » I ’Abbrechen]

Hardwareinstallation

L ] E Die Software, die fur diese Hardware installiert wird:
-
DEWESaft USE Device

hat den Windows-Logo-Test nicht bestanden, der die Kompatibilitat mit
Windaws ¥P Uiberpriift, [wWarum ist dieser Test wichtig?)

Das Fortsetzen der Installation dieser Software kann die korrekte
Funktion des Systems direkt oder in Zukunft beeintrachtigen.
Microzoft empfiehlt strengstens, die Installation jetzt abzubrechen
und sich mit dem Hardwarehersteller fur Software, die den
Windows-Logo-Test bestanden hat. in ¥erbindung zu setzen.

| Iristallation fortzetzen | [ Iristallation abbrechen
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